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Getting  
Started 

 with  
Visual Access 
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Installation 

Starting with VISUAL ACCESS 

From the CD-ROM, launch the setup program:  
« INSTALL.EXE ». 
This program proposes you to choose the software you 
want to install 
 
If you choose to install Visual Access with Alert, this 
software will be automatically configured to optimally 
run with Alert (automatic launching, sharing of the 
communication ports ). 
The default options  correspond to a standard installa-
tion for the selected language. 

If Visual Access has been provided with a hardware key (dongle), connect this key on a 
parallel port  of the PC (printer port). The hardware key can be plugged on an existing 
printer connection; it can also be plugged serially with other keys. When first launching 
Alert with a plugged dongle, the software will ask you for an installation code : this code is 
written on the warranty card (Typing definition: AAA-AAA-AAA-AAA). This code defines the 
validated options for the software. You can late change the options by entering a new code 
(Registration... button of the “About” dialog box). 
If there is no key plugged, the software will warn you at launching time. If you wish to use 
the software in demonstration mode or install it with a software key , click on the Ignore 
button . To install the software key, you must click on the Register button of the “About” 
dialog box (displayed at launching time or by the command About ALERT… of the ? menu), 
then enter the installation code which corresponds to the environment code displayed in 
the registration dialog box. To get this installation code, contact your software provider 
(after having  noted the environment code of your PC). 
When Visual Access is launched for the first time (either manually, or through Alert soft-
ware), there is not any object available. You can create a project with the project editor 
(see further on ) or load one of the projects supplied as example (« File » menu then « Open 
a project »). The available project examples are :  
-  Alert : to use this project, you must launch Alert. This project shows how to access to 
some of Alert functionalities thanks to an ANSI terminal. It also shows how to display DDE 
variables on a web page. The files of the project are saved in Visual Access « Alert » sub-
directory . The variables used in this example are DDE variables coming from Excel. If you 
want them to be displayed on the screens, launch Excel and load the ‘Demo_AL.xls’ file . 
- Ambiance : this project contains JAVA synoptics. The files of the project are located in the 
« Ambiance » sub-directory of Visual Access.  The variables used in this example are DDE 
variables coming from Excel. To make them appear on the screens, you must launch Excel 
and load the ‘Demo_VA.xls’ file. 
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Database 
To have access to the external variables, Visual Access contains a database. You 
can display a view of this database, either from  Visual Access server (‘tools’ 
menu then ‘database…’), or from the 
project editor (‘database’ icon in the pro-
ject arborescence). This window enables 
you to create, modify or suppress vari-
ables. You can also create an independ-
ent logical architecture. Thanks to this 
architecture you can reference your vari-
ables from a synoptics or a terminal 
screen. 
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A.2. Creation of keys for page changes or to have access to spe-
cial functions.  
Most of the screens have a predefined input field you can sup-
press it by ticking  ’No input field’ in the page properties), this in-
put field allows you to enter key words that are recognized by Vis-
ual Access. These key words can have different ranges, you can 
define global keys that are accessible from all the pages (Display 
the ‘Properties of the terminal server’ box, then click on  ‘Global keys’) or you can define 
them in the screen configuration (Display the properties box of the terminal screens by 
double-clicking in the screen or by choosing the ‘Properties…‘ menu, then chose the ‘keys’ 
tab). 
First, enter the name in the key edition box. This name is the one recognized by Visual Ac-
cess. You can then chose a page and a user level so as to only authorize certain persons 
to have access to the key. If your screen contains several pages, you can authorize the ac-
cess to the key only in one special page. Then chose the action that this key allows, you 
can either change the screen by selecting a screen in the drop-down list, go to the prede-
fined screen (visualization of files or loading), enter in edition mode so as to modify the val-
ues in the editable input fields or execute a remote control (change the value of a variable 
in a simple or impulsive way).  
 

C) Creation or modification of animated synoptics 
The list of synoptics already present in the project is displayed in the directory of the pro-

ject under the ‘Web’ icon in the ‘synoptics’ directory. To add a synop-
tics, chose the ‘New synoptics’ command in the contextual menu of 
the ‘Web’ icon or chose the ‘File’ menu, ‘New’ then ‘Synoptics’. 
A second directory can be found under the ‘Web’ icon , it deals with 
’HTML Pages’, this directory contains the whole HTML pages present in 
the project directory. When you save a synoptics, Visual Access editor 
can automatically generate an HTML page that contains a JAVA applet 
so as to be able to display the corresponding synoptics. To activate or 
deactivate this option, chose the ‘Options’ menu, then ‘Options…’. 
When you double-click on an HTML page, the HTML pages editor de-

fined under Windows is launched (if you have one installed on your pc). If you modify an 
HTML page which is associated to a synoptics, this one is not overwritten when you resave 
the synoptics. Only the JAVA applet parameters are updated. 
Once you have defined some synoptics, you can generate a home page containing an in-
dex positioning on the pages you have chosen. 
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Configuration of the Communication Links 
Visual Access can manage one or several modems. Each modem must be connected on 
one of the available serial ports. If the modem is a compatible one, it can be directly man-
aged by  Visual Access ; It is not necessary to install it under Windows. If Visual Access is 
used with Alert, you can share the modems and communication ports. 

A) Sharing of the modems and communication ports with ALERT 
software 
If you use Visual Access with Alert and share one or several modems or communication 
ports, you must, on the one hand, configure these modems and 
ports in  Alert (see Alert guide ), and on the other hand, activate 
the DDE communication links in  Visual Access (‘Options’ 
Menu , ‘Links…’). 

B) Configuration of the modems and communication ports 
Chose the ‘Options’ Menu, then ‘Links…’ or double click on the main window. The different 
means of communication used by  Visual Access are displayed in the dialog box that ap-
pears. To add a modem or a communication port, click on the  ‘Add…’ button. 
B.1. Modems managed by Windows 
If the modem has been installed under Windows, it can be 
selected in the «TAPI lines» list. Select one or several mo-
dems, they will be added in Visual Access when you click on 
‘OK’. 

B.2. Modem directly managed by  VISUAL ACCESS 
Select one or several ports in the « communication ports » 
list, they will be added in Visual Access when you click on 
‘OK’. You can then configure them in the ‘Links…’ box. Select 
the port you want to configure and then click on 
‘Properties…’ or double-click on the list. A dialog box appears 
in which you can configure the whole parameters concerning 
the communication port (speed, parity, format…) and the 
modem (initialization chain…). 

C) Configuration of the distant access server 
To use Visual Access as distant access server, chose the  ‘Tools’ Menu, then  ‘Project Op-
tions’, then click on the ‘Protocol‘ tab.  
In the dialog box, check in the ‘Allowed Identifications’ list that the ‘PPP’ box is well ticked. 
To modify options, double-click on the ‘PPP’ line or click on the  ‘Configuration…’ button. 
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D) Configuration of the Web server 
To use Visual Access as Web server, that is to say if you want to be able to consult HTML 
pages or animated synoptics from a local or remote Web browser,  you must activate the 
corresponding communication links. To do so, open the ’Voice…’ dialog box (In the 
’Options…’ Menu , ’Voices…’ or double-click on the main window) then tick the ‘Web 
Server’ and ‘Database (VADB)’ boxes in the ‘Other link types’ list . The ‘Database (VADB)’ 
link type allows the JAVA applets used to display the animated synoptics to  be connected 
to Visual Access in order to dynamically retrieve the value of the variables used in the syn-
optics. To modify the configuration of the web server (Home page…), use the project editor 
(see ‘Use of the project editor’ hereafter). 

Use of the project editor  
To modify a project (ANSI screen, HTML pages, animated synoptics, database, users…), 
launch Visual Access project editor either 
from the « start » button of Windows choos-
ing the ‘Micromedia’ program group or from  
Visual Access application by choosing the 
‘Tools’ menu then ‘Edit the project…’. 
 

A) User Identification 
The access control to Visual Access is 
available either by choosing an internal 
user database or through an external appli-
cation as Alert. So doing you avoid double 
user configuration that may be necessary in 
some cases. To have access to the user 
control options, select the ‘Users’ icon then 
chose ’Properties…’  in the contextual Menu or in the  ‘Display’ 
Menu. 
 
The user file is used to control the access to Visual Access at dif-
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ferent levels :  
- For the remote access server, according to the options configured in Visual Access (see 
« Configuration of the remote access server » ) 
- For the web server, according to the options configured in Visual Access (see 
« Configuration of the web server » ) 
- For the terminal server (ANSI) according to the terminal server (select the ‘Terminal’ icon 
then chose  ’Properties…’  in the contextual menu or in the ‘Display’ menu ). If the type of 
project is ‘simple’ the access control previously defined is used. If it is of ‘Alert’ type for in-
stance, the identification of names and passwords is done 
by  Alert.  
 
If you chose to use  Visual Access user management, you 
can configure the user list by double clicking on the 
‘Users’ icon in the « project » directory. If your project does 
not contain user file, you will be suggested to create one. 
 

B) Creation or modification of ANSI/Web pages 
The list of the ANSI screens present in the project is displayed in the project directory un-
der the ‘Terminal’ Icon. If you want to add a screen, chose the « New screen » command in 
the  ‘Terminal’ contextual menu of the icon or chose the  ‘File’ menu, ‘New’, then ‘Terminal 
Page’. 
 
A.1. Addition of statistical elements on a screen 
Use the ‘Text’ tool   of the tool box to write text. You can chose the at-
tributes (colors for the 40 column pages, underlined, inversed, blinking…) 
at the bottom of the toolbox. To draw lines using small boxes,  
click on        or  
You can copy the attributes placed anywhere on the screen thanks to the 
pipette 
To select a zone of static elements, use the ‘Text’ tool. Once you have selected the 
zone, you can move it with your mouse or copy it by pressing at the same time on the CTRL 
key. You can also suppress it, copy it or cut it. 
A.2. Addition of dynamic elements on a screen 
Chose the ‘Variable’ tool to display the content of a variable defined in the database.  
To display the properties of this element, double click on this element or chose 
’Properties...’ in the menu. In this dialog box, enter the name of the variable you want to 
display or directly select it in the database by clicking on  
If you directly enter a DDE reference which does not already exist in the database, this one 
will automatically be created when you use it. Then chose the way you want Visual Access 
to read this variable: either ‘Initial reading’ (The variable will only be read when displaying), 
or ‘ Continuous update’ (the variable is displayed in real time). If you want to modify the 
value of this variable, tick the ‘Authorized writing’ box. You can thus chose a ‘Conversion 
rule’ to convert the value of a variable and a ’Numeric format’ to modify the appearance of 
this value.  

Toolbox for 80 
column pages 

Toolbox for 40 
column pages 


